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Software Information

This software allows the user to start and record a Real-Time data recording, download recorded data from the
power analyzer, and plot graphs and print data lists of recorded data.

System Requirements
Operating System: Windows 7, Windows 8.1, and Windows 10

Minimum hardware requirements

PC with 1GHz or faster 32-bit (x86) or 64-bit (x64) processor 1GB RAM for (32-bit) OS or 2GB RAM for (64-bit)
0S

At least 100 MB hard disk space for the supplied software DirectX 9 graphics device with WDDM 1.0 or higher
driver 800 x 600 display resolution

Software Installation

Download the PQ3350 software from the Extech.com/software web page.

Run Extechlinstaller.exe

Select Software button to begin the installation of the device software. Proceed through the software installation
wizard using the default settings.

www.extech.com

Copyright @ 2011 Extech Instrurments Cop.

Click on the Drivers button to begin installing the USB driver. Proceed through the installation wizard using the
default settings.


http://extech.com/software
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Main Menu

FILE

« Create Data File Create a file for Real-time datalogging

« Start Recording Start recording Real-time data

« End Recording Stop a Real-time recording

« View File View a saved data file Plot Power Data Graphically plot Power data
« Plot Harmonics Graphically plot Harmonics data

« Plot Waveform Graphically plot a waveform

« Plot Hardcopy Display a hardcopy image

» Exit Exit the program

HARMONICS % (0-50 orders or 0-99 orders) Set view to %

« Phase (0-50 orders or 0-99 orders) Set view to Phase Close

+ Close window

WAVEFORM

¢ Open Open a waveform file for view

« Close Close the open waveform window

DATALOGGER

« Download recorded data from the Power Analyzer memory

OPTIONS



« Sample Rate Set data sample rate
o Com port # Select COM port number
« Baud Rate Set Baud rate for USB interface

LANGUAGE
Select the program language to English or Chinese

Operation

Turn on the Power analyzer.
Connect the Power analyzer to the PC using the provided USB cable. Set the PQ3350 to the desired

measurement mode.
Start the PQ3350 software

Under the Options menu, select the COM PORT that the meter is connected to. Note: you may need to view the
Windows Device manager to view the COM port #

Note: The PC’s COM PORT number may have to be changed between COM2 to COM16
Note: When communication is established, click the Update Now button to view the Measurement mode data that

the meter is set to.
Power Mode
Press the POWER button on the meter to set the Power Analyzer to Power mode.

Example of a 3P4W system

Fil:' Harmoniss  Waveform Daialngger Option  Language V27
System
Date Time Sample Print
[ | F1 [ s1 [ a1 [ FF1 | Phase 1
381.0V 2201V | 501.0mA  094.5W | 110.2VA  -056.6VAR  0.85 -30.9
[ V23 [ V2 [ 12 [ P2 [ 52 [ az [ PF2 [ Phase 2
381.4V 219.9V  499.9mA  0950W | 109.9VA  -055.2VAR  0.86 -30.2
[ V31 [ V3 [ 13 [ P3 [ 53 | ('E] [ PF3 | Phase 3
379.7V 219.5V | 499.2mA  0954W | 109.5VA  -053.7VAR  0.87 -29.4
VUR (Unbalance) || d0% V. ZERO) || d2% (¥. NEG.) | wWIsYS) | VA 5YS) | VAR 5YS) | PFISYS) | ’m
. 0.26% | 033% | 0.28% | 284.9W “ 3204VA | -165.5VAR “ 0.86
IUR (Unbalance) || d0% (I, ZERD) || d2% (I. NEG.) | WH 5YS) | VAH (SYS] | VARH [SYS) | PFH (SYS] |
. 0.16% | 0.68% | 0.63% | 004.9WH “ 005.7VAH | -002.9VARH “ 0.86H
Hz MD | sec [ cT | vr | W [AD) VA [AD) W (MD) | vapD) | Reset
50 [ 1 2 r 284.9W | 3294VA | 284.8W | 329.3VA

Example of a 3P3W system



d e
File Harmonics Waveform Datalogger Option  Language 702

=lol =]

System
Date Time Sample Print
[ vi2 [ n
381.0v  500.6mA
[ v23 [ 12
380,11V 499.9mA
| V3l i— = |
380.7V  408.0mA
VUR [Unbalance) | d0% (V. ZERD] || d2% [V. NEG] | W [SYS) | VA [SYS) | VAR [SYS] | PFBYS) | ’m
L 013% | 0.11% | 0.14% | 284.7W H 3204VA | -165.7VAR H 0.86
IUR (Unbalance) | d0% (1. ZERD) || d2% (1. NEG.) | WH(SYS) | VAH [5YS) | VARH (SYS) | PFH(5YS) |
. 020% | 098% | 0.94% || 004.9WH “ 005.7VAH | -002.8VARH “ 0.86H
Hz MD [ sec | T [ v W#D) | VAMD) | wMD) | vamD) | -
50 1 2 1| 1 | 2850W | 3204VA | 284.8W | 320.3VA
|}—.’uwerMode
Example of a 1P3W system
=0l x|
Fil: Harmonics Wavefonn Daialogger Option Langmage 7.2
System
Date Time Sample Print
P1 | 51 [ at [ PF1 | Phase 1
220.2V 500.6mA  094.5W  110.2VA -056.6VAR  0.85 -31.1
[ V2 [ 12 [ P2 [ 52 [ 0z [ Pr2 [ Phase 2
219.9v 499 8mA 095.1W 109.9¥VA  -055.0VAR 0.86 -30.1
wW(sYs] |  vA(SYS) | VAR(SYS) | PF(sYS) | /Ml
| 1895W | 2200VA | -111.8VAR | 0.86
WH (5v5) | VAH [SYS) |  VARH(5YS] | PFH(5YS] |
| 006.6WH | 007.7VAH | -003.9VARH | 0.86H
Hz | MD [ SEC | ©T | vT | W@ | va@o) | weoy | vam) | Heasl
50 [ 1 2 1] 1 | 1804W | 219.9VA | 189.5W | 220.0VA

Get Setup |
|iner Mode

Example of a 1P2W system




¥ Power Harmonics Analyzer = m} *

File Harmonics Waveform Datalogger Option  Language Help V7.00

System

Date Time Sample Print

V1 1 Phase 1
116.8V 10.41A -178.1

W(SYS) | VA(SYS) VAR (5Y5) PF(5YS) | | PHASOR

-01.20KW  01.20KVA  00.00KVAR  -1.00

WH (55) VAH (5Y5) VARH (575) PFH (5'5)
00.00KWH | 00.00KVAH 00.00KVARH | -1.00H |
" Hz | MD [sec [ cr [ vi | wem  vam | wo vapupy | < Reset
e | 15 2 | 1 | 1 e

Update Now
Power Mode

NOTE: If the power system is changed after the program is run or the data displayed is off by a factor of X10,
press the Update Now button to obtain the updated setup from the meter.

Phasor Diagram

With the Power Analyzer is set to Power mode,
Press the PHASE button on the meter to display a phase diagram:

Harma =l
File Hammomics Waveform Datelogger Jption  Lenguage V2.2
[ System _
Date Time Sample Print
[ viz | ¥i [ n H P1 [ 51 [ a1 | PF1 | Phase 1
381.0V 220V | 501.0mA  094.5W  110.2VA  -056.6VAR  0.85  -30.9
[ V23 I V2 [ 12 [ P2 [ 52 [ a2 [ PF2 | Phase 2
3814V 219.9V  490.9mA  095.0W  100.9VA  055.2VAR  0.86  -30.2
[ V3l I V3 [ 13 [ P3 [ 53 [ a3 [ PF3 | Phase 3
3797V 2195V | 499.2mA  0954W  100.5VA | -053.7VAR  0.87  -204
VUR [Unbalance] | d0% [V. ZERO]| d2% [V. NEG.) | W [STS) | VA [SYS) | VAR(SYS) | PF(SYS) | ’m
| 0.26% | 0.33% | 0.28% | 284.9W U 3204VA | -165.5VAR H 0.86
IUR [Unbalance) | d0% (1. ZERD) || d2% (1. NEG.] | WHISYS] |  VAH(SYS) |  VARHISYS] | PFH(5YS] |
| 0.16% | 0.68% | 0.63% | 004.9WH H 005.7VAH | -002.9VARH H 0.86H
Hz MD [ sec [ cT | vT | WD) | VA@AD) |  wmMDl | vAmMD) || Reset
50 | 1 2 | 1 | 1 | 284.9W | 3204VA | 284.3W | 320.3VA

Example of a 3P4W or 3P3W system



=0l x|

[F=vives [ 1199 Allveclors | v123| 123 | Vi |
| W2 W3 1203

——Ei 13 438.9m4, 905> __
[=i> [1189 ¥3<2194,1198> S

| <|2 13> 1195
| <3 11= 1216
|<V12,V23> 1201 I'.
[<v23 w31 [ 1199 h .

W31 < 380.2v,150.0 > W12 < 380.8v, 30.0 »

W1 < 2201%, 00>

[evar vizs [ 1200 PEEERIVRECOIRR \“\ 2 1< E006me, 311>

~ __’P_/ il

o o
V2< 21891199 Ses e T
¥ng ‘| Ing |

| 001.5V U 012.8mA V23 ¢ 381.0%, 901 »
VUR (Unbalance) || d0% (V. ZERD) || d2% (¥, NEG.) || 1UR (Unbalance) || d0% 0. ZERO) || d2% 0. NEG.) |
. 012% | 022% | 0.413% | 0.48% | 0.85% | 081%

Vng: The calculated difference of potential between neutral and absolute ground.
In: The calculated difference of the current to neutral.

Example of a 1P3W system

AM

=lolx]

B II
0. T_J ® v czovocs
[ i /‘ 4
12 ¢ 499.8mé, 160.0> . - - / /1 < 500.3mé, -30.9 >

W2 219.9, 1199 e =i

Example of a 1P2W system
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Harmonics Mode
Press the Harmonics button on the meter to view Harmonics data.

When the Power Analyzer is in the Harmonics mode, the following window will be shown:

= =10l x|
aveform Datlogeer Option Language V22
| System mE E
Date Time Sample | Index | HZ | % [ Angle .
_paw [ T 1 [ e (100 7is ot
HARMONICS (%, 60Hz )
100 —
80—
60—
11
40
20 1
0 [ 4 .
0 5 30 35 40 45 gD
Order -->»
[ DATE | TME | AMs | PEAK+ | PEAK- | CF. | THDT | i)
Get Setup 005/216 | 162441 | 2050mA | ©20mA | -B056mA | 347 | 99.0% | 203.0mA

Use the horizontal scroll bar to select the desired Order of harmonics.
Index: Selected order

Hz: Frequency of selected order

%: Percentage of selected order with respect to 1st harmonic
Angle: Phase angle of selected order of harmonics

Date: Current date Time: Current time

RMS: the true RMS value of selected input

PEAK+: positive peak value of selected input

PEAK-: negative peak value of selected input.

C.F.: Crest Factor

THD-F: Total Harmonic Distortion

VI(1): True RMS value of first harmonics of selected input.




NOTE: To select the desired input (V1, V2, V3, I1, 12, I3), use the button on the Analyzer.

i yzer il =10] x|
File Hermonics Waveform Datelogger Option Language V22
| System |y
Date Time Sample | Index | HZ | % | Angle -
B0 et e e 1 | s 1000 [ sz A
HARMONICS (%, 60Hz )
100 —
80 1
60 I
Vi
40
20
4] t
0 5 10 15 20 25 20 35 40 45 50
Order --»
DATE | TME | BMS | PEAK= | PEAK- | CF._ [ THDF | vin)
Get Setup [2005/2716 | 16:22562 | 1121V | 1603 | 1568v | 142 | 07% | 113.%

Users have the option to display % (percentage) or phase angle. Users can select and Display the Harmonics
order from 0 — 50 or 0- 99.
=i 1 =10l %]

File | Harmonies Waveform  Datelogger Option Languege V22
|—c“ 50 Crders Eil B
> pha » 000 :
:lme ] Time Sample | Index | HZ \ %% |Angle Print
| 5 [ 300 | 356 | -11.4
HARMONICS (%, 60Hz )
100 17—
30 +—
Il
15 0 5 30 35 40 45 EO
Order -->»
1
Get Setup |~ DATE [ TME [ RMS [ PEAK+ | PEAK- | CF [ THDF [ wvim
I—Hﬂrmo_ and | 2005/2/23 | 135648 | 263.1mA | BO046mA | 8919mA | 284 | 949% | 2052mA
Waveform

Waveform Mode

Set the Power Analyzer to Harmonics mode.

Open Waveform menu and select open. When the meter is connected to a live circuit, a waveform will appear.
Open the Waveform menu and select Close to close this window.

To view a saved Waveform, Open the main FILE menu and select Plot Waveform. Choose a saved Waveform file
to open and view. Click File menu and exit to close the waveform window.

Example of V1 input



File Hammonics Waveform  Datelogger Option  Languvage V22

‘ System
Wavelorm (60Hz)
200
150 ,.‘—‘-'J*k
100 P

=

Py
pE N
- 28 PEH Bad % A0 768 G5 /
|

150

=200
Time -->
DATE | TIME [ AMS | PEAKs | PEAK- CF. [ THD-F | ¥
Get Setup 200572716 | 162559 | T3 | 1618v | 588 | 143 | 08x | 1131V

Date: Current date

Time: Current time

RMS: the true RMS value of selected input

PEAKZ«+: positive peak value of selected input

PEAK-: negative peak value of selected input.

C.F.: Crest Factor

THD-F: Total Harmonic Distortion

VI(1): True RMS value of first harmonics of selected input.

NOTE: To select the desired input (V1, V2, V3, I1, 12, 13), use the button on the Analyzer.

Example of I1 input

T B [l |
File Hammonics Wavefurm Datelogger Option Language 220
‘ System
Waveform (60Hz)
1000
300 ‘\
600 \
400 h
200 i
Il 5 X
1L 28 53] Fad Blz y 768 95
-200 )J
400 Vel
£00
=00
-1000
Time -->
DATE | TIME [ HAMS | PEAKs | PEAK- | CF. [ THD-F | ¥
Get Setup 2005/2716 | 16:26:50 | 2/9.2mA | Saz6mA | B8Z2mA | 352 | 1009% | 1965mA

Download Recorded Data

The analyzer can store up to 85 files. Each file can contain a combination of Power data, Harmonic data, or
Hardcopies of a meter display window.

First — Select the Desired Data File from the Meter

Set the Meter to POWER mode.

Press Setup button on the Power Analyzer meter.

The Down Load File parameter will indicate what data file is being viewed in the display. Use the Right or Left



Arrows on the meter to select what data file you want to download.

The first letter indicates the Data file type.

o P =Power Data
« H =Harmonics data
« H = Hard copy (Power Analyzer screen copy)
The numbers indicate the File number and Total number of files of that type.

Example P 2:4 (Power Data, file #2 is being viewed and there are a total of 4 Power files)

Once the file is selected, Press the EXIT button, otherwise you will not be able to transfer the data.

Down Load Power Data
If the data file stored is power data, press the Down Load Power Data button.

- (O] x|
. DATALOGGER SETUP i Eﬁﬁfum 99
SYSTEM [REC) HZ (REC] a9 P
3P4 50
MD [REC) SEC [REC] Clear Memory
15 2
CT [REC] FT [REC] :
1 1 ‘Down Load Power Data!
Type ol Data File Index
Power b .
Down Load Harmonics
Down Load Hardcopy
Down Load All Files
D ate Time
VY YY-MM-DD) {HH:MM:55]
2005-08-03 10:22-43 Down Load Transient

Once the button is pressed, enter a file name and the data will transfer to the PC.

In the Software, Open the Datalogger menu and click on the button. The Type of Data should be Power, click
Down Load Power Data

Example of Power Data Stored



_|of x|
DATALOGGER SETUP dp":sls to get .
SYSTEM [REC) HZ [REC) Salbgacreplip
3P4 50
MD [REC) SEC [REC] Clear Memory
15 2
CT (REC] FT (REC)
1 1 Down Load Power Data
Type ol Data File Index
Power b -
Diown Load Harmonics
Down Load Hardcopy
Diown Load All Files
Date Time
OYYYY-MM-DD] (HH:MM:55]
2005-08-03 10:22-42 Down Load Transient

Down Load Harmonics Data
If the data stored is Harmonics data, press the Down Load Harmonics button.
. SE

':I Drata

Press to get

DATALOGGER SETUP i
SYSTEM [REC) HZ [REC) dateloggkisewp
3P 50
MD (REC) SEC (REC) Clear Memory
15 2
CT (REC) FT [REC)
1 1 Down Load Power Data
Type ol Data File Index
Harmonics 3 ;
i Down Load Harmonics |

Down Load Hardcopy

Diown Load All Files

Date Time
OrYYY-MM-DD) (HH:MM:55)
2005-08-03 10:21-48 Down Load Transient

Once the button is pressed, enter a file name and the data will transfer to the PC.

Example of Harmonics Data Stored



Press to get

DATALOGGER SETUP

datalogger setup

SYSTEM [REC) HZ (REC)
3P4W 50
MD (REC) SEC [REC) Clear Memory
15 2
CT [REC) PT [REC)
1 1 Down Load Power Data
Type of Data File Index
Harmonics 3 -
Down Load Harmonics
Down Load Hardcopy
Down Load All Files
D ate Time
[YYYY-MM-DD] [HH:MM:55]
2005-08-03 10:21:48 Down Load Transient

=0l x|

Down Load Hardcopy Data
If the data stored is Hardcopy data, press the Down Load Hardcopy bu

tton.

Press to get

=101 %]

DATALOGGER SETUP i ol .
SYSTEM [REC]) HZ [RELC) AEINganrEep
IPAW 50
MD [REC) SEC [REC) Clear Memory
15 2
CT [REC) PT [RELC]
1 1 Down Load Power Data
Type of Data File Index
Hardcopy 12 .
Down Load Harmonics
. Down Load Hardcopy !
Dowwn Load All Files
Date Time
Y'Y -MM-DD) [HH:MM:55]
2001-08-03 16-49-49 Down Load Transient

Example of Hardcopy Data Stored

Once the button is pressed, enter a file name and the data will transfer to the PC.



_[ol x|
| DATALOGGER SETUP i dpr?sf 1o get ;
SYSTEM [REC) HZ [REC) EIOaRLEaTR
IPAW 50
MD (REC) SEC [REC) Clear Memory
15 Z
CT (REC) PT (REC]
1 1 Down Load Power Data
Type of Data File Index
Hardcopy 12 .
Down Load Harmonics
. Down Load Hardcopy :
Down Load All Files
Date Time
[rYYY-MM-DD] (HH:MM:55] .
2001-08-032 16-49-49 Down Load Transient

Down Load Transient Data
The Power Analyzer can send Transient data in Real-time but only through the PC interface when the

TRANSIENT button is pressed.

NOTE: It cannot record Transient data to the meter memory.

1. Connect the RS-232 cable between the Power Analyzer and the PC.

2. Run the PQ3350 software and select the Datalogger menu.

3. Press the Down Load Transient button. The User will be prompted to enter a file name to store the transient
data. The program will wait for the data to transfer for up to 10 seconds.

4. Press the TRANSIENT button on the meter front panel.
The transient data will start streaming to the PC.

5. Press the EXIT button on the meter to Stop capturing Transient data.



=10l x|
| DATALOGGER SETUP i 5":5? to get \
SYSTEM [REC) HZ (REC] clelhggsrasR
MD [FEC) SEC [REC] Clear Memory
CT (REC) FT [REC)
Down Load Power Data
Type ol Data File Index
Down Load Harmonics
Down Load Hardcopy
Diown Load All Files
Date Time
Y -MM-DD) [HH:MM:55] ; -
Textl Textl i Down Load Transient

Clear All Data from Meter Memory

In order to clear meter memory of all data, you must connect the meter to the software.
NOTE: you cannot clear meter memory with the meter only.

To clear all data stored in the Power analyzer, Connect the meter to the PC and run the PQ3350 software. Select
the Datalogger menu.

Click on “i” to view datalogger setup

Press the Clear Memory button. A beep will sound as all of the data in the meter memory is cleared.

- (O] x|
| DATALOGGER SETUP i E":SIS to get .
SYSTEM [REC) HZ [REC) alefggsreeiug
MD [REC) SEC [REC] Clear Memory
CT [REC] FT [REC]
Down Load Power Data
Type ol Data File Index
Down Load Harmonics
Down Load Hardcopy
Down Load All Files
Date Time
DY -MM-DD) [HH:MM:55]
Textl Textl Down Load Transient

Real-Time Data Logging

1. Enter Sampling Rate
Open the OPTION menu; Select Sample Rate to enter sampling time in seconds. The minimum sampling time
is 2 seconds for Power and Harmonics data. The minimum sampling time is 4 seconds for Waveform data.
Set the measurement Mode: (Power, Harmonics, or Waveform)
NOTE: If Power data is displayed, then Power data is stored in the file.
If the Harmonic bar graph is displayed, then Harmonic data is stored in the file.

If a Waveform is displayed, Waveform data is stored in the file



nd. Harmon:s

yzer

Harmonics  Weveform Datelogeer | Option Lenguage V22

=10 x|

System _
[ Date | ;
2005/2{23
\ vi2 [ V1 \ n I Pl [ 51 \ o G | Phase 1
379.1V 220.2V 500.3mA 053.3W 110.1VA | -096.3VAR 0.48 -60.7
I V23 [ V2 I 12 [ P2 [ 52 I 0z [ Pr2 [ Phase 2
380.3V 219.9v 500.5mA 054.7W 110.0VA | -095.4VAR 0.49 -60.8
I V3l [ V3 I 13 [ P3 [ 53 I a3 [ P [ Phase 3
3824V 219.3V 501.4mA 055.9W 109.9VA | -094 VAR 0.50 -60.2
VUR (Unbalance) || d0% [¥. ZERO] || d2% (V. NEG.) | wisYs) | VA(SYS) | VAR (SYS) | PF(SYS) | PHASORI
. 047% | 0.67% || 051% | 164.0W | 320.8VA | -286.2VAR | 049
IUR [Unbalancel || d0% (1, ZERD] || d2% (I, MEG.) | WHISYS) |  VAHI(SYS] |  VARH(SYS) | PFH(SYS) || [/
_ 0.14% | 1.14% || 1.25%  000.5WH | 000.9VAH “ 000.8VARH “ 0.49H
Hz | MD [sec | cr [ wvr | __wepy | wvage) | wmD) | vAMD) | Reset
s0 [ 15 | 2 L] 1 163.9W | 320.8VA | —— | o
Giet Setup
Fower Mode
2. Create a Data File.
Open the FILE menu and Select Create Data File.
Enter a file name.
E Power Harmonics Analyzer - m}
File Harmonics Waveform Datalogger Option  Language Help  V7.00
Create Data File Ik
Start Recording Time Sample 2
End Recording i ﬁ Print
View File V1 n Phase 1
Plot Power Data
= 116.4V  10.38A -178.0
Plot Waveform
Plot Hardcopy
Exit
W (SYS) YA (5Y5) VAR (SYS) PF(5Y5) ||| PHASOR
-01.17KW | 01.17KVA | -00.24KVAR -1.00
 WH (SYS) VAH [5Y5) VARH [5Y5) PFH [5Y5]
-00.26KWH 00.26KVAH 00.06KVARH  -0.98H
| | I <-Reset
_Hz [ MD [sec | cT | vi | wen VA [AD) W (D) VA (MD)
|60 | 15 | 2 [ 1 | 1 -01.00KW 01.01KVA === 01.01KVA
Power Mode

3. Start Recording

From the FILE menu, Select Start Recording. When Auto is selected, data will be recorded at the programmed
Sampling rate



E Power Harmonics Analyzer = m} x
File Harmonics Waveform Datalogger Option Language Help V7.00

Create Data File = Real-Time data - 3.csv |

Start Recording L\\‘, > Auto
End Recording Manually
icw FRe vi i Phase 1
Plot Power Data
116.6V 04.29A -177.8

Plot Harmonics
Plot Waveform
Plot Hardcopy

Bt
W (5YS) VA (5YS] VAR (5Y5] PF (5YS)
-00.36KW | 00.45KVA -00.30KVAR -0.80
wH [5Y5) YAH [SYS) YARH [SYS] PFH (SYS)
-00.38KWH  00.39KVAH 00.08KVARH -0.98H
‘ Hz ‘ MD |SEC] CT l VT | W |AD) VA [AD] WMD) VA [MD) UL
| 60 [ 15 | 2 [ 1 | 1 -01.00KW 01.01KVA - 01.01KVA

Update Now
Power Mode

When Manual is selected, a Record button will appear in the window. One data point will be recorded with each

press of the Record button.

P Power Harmonics Analyzer — o x

File Harmonics Waveform Datalogger Option Language Help V7.00

System

Date Time Sample :
= i mEGw

Vi n Phase 1
116.1V 10.38A -178.2

W [5Y5] VA [5Y5) VAR (575) FF(5Y5) | | PHASOR

-01.17TKW | 01.17KVA | -00.24KVAR | -1.00

WH [SYS) VAH [SYS) VARH [SYS5) PFH [5YS])
-00.34KWH | 00.35KVAH (00.07KVARH | -0.98H

[ Hz [ MD [sEc [ cT [ vi | wen VA (AD) W (MD) VA (MD) sz Heset
\ 60 \ 15 | 2 \ 1 \ 1 -01.00KW [01.01KVA 01.01KVA

Update Now
Power Mode

4. End Recording
From the FILE menu, Select End Recording. The data file will be closed and will now contain the recorded

Real-time data



E Power Harmonics Analyzer L ) X
File Harmonics Waveform Datalegger Option  Language Help  V7.00

Create Data File = Real-Time data - 2.csv

Start Rezording
2 ample .
End Recording % ﬁ Print REﬁi‘d

View Filz w1 n Phase 1

Plot Power Data
116.4V 10.38A -178.0

Plot Harmonics
Plot Waveform
Plot Hardcopy

Biit
W [5Y5] VA [5Y5]) VAR [5Y5) PF [5Y5]
0117KW | 01.17KVA | -00.24KVAR -1.00
WH [5Y5] VAH [S5Y5) YARH [5Y5] PFH [5Y5]
-00.37KWH 00.38KVAH 00.08KVARH  -0.98H
| Hz MD |SEC| cT | vT ‘ W (AD) VA [AD) W (MD) VA (MD) SR
60 | 15 [ 2 | 1 | 1 -01.00KW 01.01KVA | -— 01.01KVA
Update Now
Power Mode
View File
The Data points are stored in a comma delimited file format (.csv)
Open the data file by selecting View File from the FILE menu.
Note: Any text editor can open the data file.
E Power Harmonics Analyzer T O
File Harmonics Waveform Datalegger Option  Language Help  V7.00
Create Data File
Start Recording | Time Samp|e B
End Recording It
el [s vi i Phase 1
Plot Power Data
I 1163V 09.84A -178.2
Plot Waveform
Plet Hardcopy
Exit
W [5Y5]) VA [5YS] VAR [SY5S) PF [5Y5] PHASOR
-01.05KW | 01.11KVA @ -00.42KVAR -0.94
WH [5Y5] VAH [5Y5]) VARH [5Y5) PFH [5Y5)
-00.24KWH | 00.24KVAH 00.05KVARH -0.98H
<- Reset
‘ Hz | MD ‘SEC‘ T ‘ VT ‘ W [AD] VA [AD) W (MD) YA [MD]
60 [ 15 [ 2 | 1 | 1 [/ R R

Power Mode

Enter a file name from the File menu.
Data will appear as shown in the window below:



5 =] 3
3P4V, Hz=50, MD=15 , SEC=2 ,CT=1, ¥T=1, INPUT=I 1 j
DATE TIME, V12 ¥23 Y31 V1 ¥2 V3 T1,I2 I3 P1 P2 P3, 51 52 53 01,02 03, PF1,PF2 PF3 Phasel Phase?, Phase3
: : ’ : 2 . : ) . &miL,
2005-02-23, 16:12:09, 382 1V, 380_ 2V, 379_6V, 220 1V, 219 9V, 219 4V, 500_ 6mA,
2005-02-23, 16:12:11, 383_0V, 3799V, 379._2V, 220_1V, 220_0V, 219_4V, 500_ 6mA,
2005-02-23, 16:12:13, 381_ 2V, 3799V, 381._2V, 2202V, 220_0v, 219 4V, 500_ 6mA,
2005-02-23, 16:12:15, 3837V, 380_4V, 377_9V, 220 1V, 219 9V, 219 4V, 500_ 6mA,
2005-02-23, 16:12:17, 3832V, 380_5V, 378_4V, 220 1V, 220_0V, 219 4V, 500_ 6mA,
2005-02-23, 16:12:19, 382 1V, 3799V, 380_3V, 2202V, 220_0V, 219_4V, 500_ 6mA,
2005-02-23, 16:12:21, 383_0V, 379_0V, 380_1V, 2202V, 219 9V, 219 4V, 500_ 6mA,
2005-02-23, 16:12:23, 3793V, 382 9V, 379._9V, 2202V, 219 9V, 219 4V, 500_HmA,
2005-02-23, 16:12:25, 379_8YV, 281._1vV, 3815V, 2202V, 220_0v, 219_5¥,  500.6mA,
2005-02-23, 16:12:27, 280_9V, 380_9V, 380_2V, 2202V, 219_9v, 219_3¥,  500.5mA,
2005-02-23, 16:12:29, 3792V, 381._4YV, 3816V, 2202V, 220._0v, 219_4¥,  500.6mA,
2005-02-23, 16:12:31, 379_8Y, 3822V, 3803V, 2202V, 220_0v, 219_4¥,  500.5mA,
2005-02-23, 16:12:3%, 280_0V, 382 1V, 3798V, 220_1vV, 219_9v, 219_4¥, 500.6mA, ™
Selected Record | 3 |
2005-02-23. 16:12:07. 381.3¥. 3809V, 380.0v. 220.1¥. 220.0¢. 219.4Y., 500.6mA. 500.9mA. 500.3mA,
053.3w, 054.8W. 0558w, 110.1¥A. 1101¥A, 109.7¥A, -096.3¥AR, -095 4¥AR, -094 4VAR, 0.48, 0.49,
0.50, -61.4. -60.4, -59.3. 163.9%. 329.7VA. -2B6.1VAR. 0.49. 000.1WH. 000 2VAH.-0D0.2¥ARH., 0.49H.
163.9%, 329.7%A. - . i

Plot Power Data

Select a Power Data file to Graph

The Power data stored by the PC in Real-time or Down loaded from the analyzer can be viewed in a graph format

by selecting Plot Power Data item from the File menu

E Power Harmonics Analyzer

File Harmonics Waveform Datalogger Option Language Help V7.00

Create Data File

Start Recording | Time Sample ]
End Recording w Print
View File
Plot Power Data
Plot Harmonics
Plot Waveform
Plot Hardcopy
Exit
W [5Y5])
-01.17KW
WH [5Y5]
-00.22KWH
| Hz | MD [sEc | cT | vi | wen
|60 [ 15 [ 2 [ 1 | 1

Power Mode

V12 data is shown below:

Vi

115.8V

VA [SYS)
01.17KVA

VAH [5Y5)

00.22KVAH
VA [AD)

" Phase 1

10.38A -178.1

VAR [5Y5) PF [5Y5)

-00.24KVAR -1.00

WARH [575) PFH [575])
00.05KVARH -0.98H

<- Reset
W [MD] VA [MD]



m Power Analyzer -- Plot Data

File Selact Zeale X Label Title Crd Zoom

115

110 1

105

Stats Clear Print

3PAW

=10l x|

Lt 14:26:04

14:26:12

Time

14:26:28

" 14:26:36

Click on the Select menu to plot other power parameters

12
723
V31
i1
V2
W3
i
12
3
31
P2
B3
V12 g
b
33
o}
2
Q2
FFL
PR2

File | SeLect

Tifle Grid Zoom Statis Clear Print

3P4W

__________

BF3 04 "14:26:12
Phasal

Phase2

v Phase3

" 142620
Time

" 1426:28

" 14:26:36

=1B1x|

P_SYS
3_8vs
2 878
PE_5VS
WH

M

M

PFH
WAD)
VA(AD)
WD)
7AMD)

Plot Power Data — Statistics

The program can also plot statistical data such as Max, Min, Mean, and Standard Deviation.
Click on the Status menu and choose the type of plot




er -- Plot Data

=0l x|

File Select Scale X Label Tifle Ord Zoom | Statis Clear Print
None
Iean
Manbdaz
Mean and Minbdax
157 StiDew
3tdDey and Mean
| _____ StiDevandMinMax [ i
T 3tADey and Minhdaw and bean e | s | TS | T
BlextFit i
CE0, S | s—————— . . S ol
105 +
100 } | | } |
14:26:04 14:26:12 14:26:20 14:26:28 14:26:36
Time
Plot Harmonics ' ]
The Harmonics data down loaded from the analyzer can be graphed by selecting.
Click on the FILE menu and choose Plot Harmonics Data
B Power Harmonics Analyzer = m} x
File Harmonics Waveform Datalogger Option  Language Help V7.00
Create Data File
Start Recording Time Sample i
End Recording i w ﬁ Print
View File Vi n Phase 1
Plot Power Data | 1
B 116.1V 10.38A -177.9
Plot Waveform L\’
Plot Hardcopy
Exit
W (5¥S) VA (5Y5) VAR (5¥S) | PF(5YS) |
01.17KW  01.17KVA -00.24KVAR = -1.00
WH(SYS) |  VAH(SYS) VARH [5Y5) PFH [5Y5)
-00.20KWH 00.21KVAH 00.04KVARH -0.98H
| Hz [ MD [sec [ ct [ vi | wem VA (AD) WMD) | VA(MD) < Reset
| 60 | 15 | 2 [ 1 | 1 i N N
,7}'»0\;;?&“9

Select a saved Harmonics data file to view the data.




|;|I-'1|:-t Harmomnics o ] B4

File Option  Print

DATE TIME RMS PEAK+ PEAK- C.F. THD-F W (1) HZ TOTAL il
2005/2723 | 16:52:42 | 288.1mA|  B40.2ZmA | -914.6mA 282 94.0% | 209.8ma B0Hz 4

HARMONICS (%) HETo0Dx
100 5

Order --> H25 T

The number under the TOTAL label indicates the set number for harmonics data stored in the file.
Use the vertical scroll bar to plot a specific set of harmonics data. To see the percentage (%) of a specific order,
use the other vertical scroll bar.

5 N l=lF3
File Option Print
DATE TIME RS PEAK+ PEAK- R THD-F (1) HE TOTAL i’
20052123 16:52:42 | 288.1mAl  B402mA | 914 6mA 2492 94.0% | 209.8mA GOHz 4
INDEX
1]
HO  O0% =
HARMONICS (%) Hi 1L
166 HZ  70.3%
Hi 57z
HE  34.4%
HE  59%
HF  25.9%
801 HE  EBE%
HI  245%
HID  61%
HIT  14.2%
6011 H12  Bax
i H1Z  116%
H14 55
101 HIE 126%
HIE  57%
HIT  92%
H18  60%
01 | H13  61%
Hz0 57
H21  48%
Hz2  55%
0 H23  62%
H24  54%
H25  63%
H2E  55%
Order --> Her 4w |

Plot Waveform
Click on the File menu and select Plot Waveform



E Power Harmonics Analyzer e O X

File Harmonics Waveform Datalogger Option Language Help
Create Data File

Start Recording Time Sample ]
End Recording i w Print

View File Vi i Phase 1

Plot Power Data
116.3V 01.89A -097.0

Plot Harmonics

Plot Waveform I}
Plot Hardcopy

Exit

W (5YS) VA [5YS) VAR [SYS) PF(5YS) | | PHASOR

-00.06KW | 00.18KVA | -00.18KVAR -0.33
WH [575) VAH [5Y5) VARH (5Y5) PFH (5YS)

-00.19KWH 00.19KVAH 00.04KVARH -0.98H
‘. Hz ‘ MD ‘ SEC ‘ cT ‘ VT ‘ W [AD) VA (AD) W [MD) VA (MD)
1

<- Reset

=101 ]

File' Opfion  Print

DATE TIME RME PEAK+ PEAK- C.F. THD-F W (1) HZ TOTAL ﬂ
20058/2/23 | 16:42:00 | 499.1mA | 707.5mé | -707.5mA 1.42 0.0% 499 4ma | 80Hz 3

INDEX

iy |

TSRS |
338 85273
Waveform (50Hz) 339 82121
1000 66,328

800 1001 -72.645
1002 -EB.322

1003 53634

600 ff‘ \-\\ 1004 -47.377
1005 -44.219

400 1“ N 1006 -47.377
/ \ 1007 -44.219

1008 -31.585

200 1009 -28.426
\ 1010 22109
1011 -18.951

12g  ES6 Ba4 %.2 pad |68 96 / 181% :1321-234

200 1014 -9.475
\ / 1015 15,732
1016 0.0
400 \ F g 1017 B.217
00 h, / 1018 6317
1019 9.475
et 1020 15.792
1021 28.426
800 1022 18951

i et 1023 26.268
Tlme > 1024 25268 j

=

The number under the TOTAL label indicates the set number for the waveform data stored in the file. Use the
vertical scroll bar to plot a specific set of waveform data.

Each waveform consists of 1024 points of data. To see the value of a specific point, use the upper vertical scroll
bar.

NOTE: The values for all of the 1024 data points are used for reference only. They are not calibrated, as is the
RMS value. 32 PQ3350-SW-HELP-EN_V2.0 10/19

Plot Hardcopy
Click on the FILE menu and select Plot Hardcopy



[ Power Harmonics Analyzer = O X

File = Harmonics Waveform Datalogger Optien Language Help V7.00
Create Data File

Start Recording Time Sample ] i

View File i ] n 'Pﬁ'aéa 1 |

Plot Power Data I - i =
116.1V 10.11A -178.2

Plot Harmonics
Plot Waveform
Plot Hardcopy D%

Exit
W [5Y5] YA [SYS) VAR [5Y5) PF [SY5]) _
-00.96KW  01.14KVA -00.66KVAR -0.84
WH [SY5) VAH [5YS) VARH [SY5]) PFH [5Y5) |
-00.21KWH 00.21KVAH 00.05KVARH -0.98H
[tz [ MD [sec | o [ V7 | s s bl et
[ s0 |15 | 2 | 1 | 1 [
‘inerMode
The Hardcopy window will appear as shown below.
From the File menu, Select the File to view the hardcopy data.
v of Window =10 x|

| | PRINT |

Examples of Hardcopy Data

Hardcopy image of Power Data



'ﬁ Hardco P o f Window

Uiz

Il

=10l %]

File

Ui 1228.8 0 @.@ o

e 18,1 U=-126.3 = I3

U3F 1228.8 ) 119.7 =

11 2499, TmA— 26.7 ° Uz

12 :502.3mA-149.2 = 34

1% :581.5mAa 98.5 =

TUne 21.2mA 1.9 U

Mz:358. & U 28,7 = Ui
PYE313e8.2 - 9g.2 =

U3i:13e@.4 U 149,85 o

Ave: 380.4 U Soi.im I2 2

diz: B2 &

UUR: @.16 ]

diz: 8,38% 0.08% V23
REF:118.8 U _
SP4UHZ: 58, 85d%: SCT: 1UT: 1 CEELT

\ 2005-08-09 14:52:24 |

| Exarnple of Phasor Diagram Hardcopy

PRINT |

Hardcopy image of a Phasor Diagram

iw. Hardeo P o f Window

=10l %]

789 Brark] s s yrosass sy

i

BH4o9. cral 0 1t 50
HZ: 58.8 . 188, If4?? 9nn
Thd: 8.8 % SEC: 2CT: 1UTH 1 EEE1S

\ 2005-08-09 1452:39 |

| Exarnple of Harmonics|and Waveform Hardcopy

Hardcopy image of a waveform display




iw, Hardcopy of Window . = IDIﬂ

HZ: 5@8.8 226.8 U 499.8
ge22e-2 0 WS o
\ 2005-08-09 145252 |

| Example of Waveform Hardcopy PRINT |
Print Data

Each page in the software has a Print button.
Click on the Print button to the print an image of the data on the page.
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